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1 Introduction

1.1 About LAMA

Feedback

64 Bit

Thank you for your interest in LAMA -the "LAMA Audio
Measurement Application”!

LAMA is a powerful software designed for acoustic mea-
surements and Audio-System-Tuning in the field of live
sound reinforcement.

It is exclusively designed for the Apple Macintosh and be-
sides of technical perfection, usability has been a major
design approach. LAMA brings powerful tools you will
never want to miss at your live-sound desk.

We are very happy if you provide feedback to us, as it
helps to make LAMA even better. In case of a crash,
LAMA will ask you to send a crash-report. Please do so,
as we can fix the bug which caused the issue — note that
crash-reports sent to Apple are not forwarded to other
developers.

LAMA operates in 64 bit mode with Mac OS X Snow
Leopard and takes full advantage of the CPU power of
your Intel Macintosh.

1.1.1 Getting Started

Installation

System Requirements

Macintosh

There is no special installation procedure for LAMA. All
you need to do, is to drag the application icon somewhere
on to your computer’s hard disk — the ”Applications”
folder might be a very good location for LAMA.

To run LAMA, a Macintosh Computer with OS X Version
10.5 (Leopard) is required. Every Mac that is able to run
Leopard should be able to run LAMA — so you need at
least a 867 MHz G4 processor. All Intel Macs are able
to run LAMA, too. (Lama is delivered as a ”Universal
Binary”, so it works with PowerPC and Intel processors.)



Audio Requirements

Support

— Troubleshooting

To run LAMA in 64-bit mode, Mac OS X 10.6 is required.
Of course, an audio-measurement application needs some
kind of audio-hardware to get audio-signals into your com-
puter. The internal hardware is sufficient, but you might
want to get some kind of more professional audio-equipment
for serious work. Every Core-Audio compatible audio in-
terface should be able to work with LAMA.

If you need any kind of technical support don’t hesi-
tate to contact the makers of LAMA: Visit the website
http://lama-audio.net/support| or send an email:
contact@lama-audio.net.
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1.2 Quick Start

— 211 Main Window

When you launch LAMA for the first time, you will see
the Main Window:

800 LAMA =
@ & Recorder 1
D # Meter
Meter
(=] (=],

It consists of various parts: the toolbar on top and two
tables: The upper one shows the currently active instru-
ments and the one below those recently used. You can
make one of the recent instruments active again, by double-
clicking it. If you want to delete it, click the "-" button
below or select the item and hit BACKSPACE on your key-
board.

1.2.1 Audio Settings Window

— [ Aux Inputs

Clip Notifications

Before you go on, you might want to adjust LAMA’s Au-
dio Settings to your need. Choose View » Audio Settings
or use the keyboard-shortcut CMD-ENTER to open the
Audio Settings Window:

On the top you can see the Audio Device pop-up menu.
It is used to select the audio-device which LAMA should
use for input. Furthermore, you have the ability to cre-
ate three different Aua-Inputs (File Player, Net Receive
& Signal Generator) —additional ”devices” that add au-
dio input to your instruments— and Summing-Channels.
Summing Channels — additional input channels with the
sum and the difference of two other input channels.

The Audio Device currently used can also be changed with
the Audio Settings toolbar menu.

Enable Send Growl Notification on Clipping to be

1 Introduction



informed with Growl when clipping occurs on one of the
audio input channels. Growl is an external System Exten-
sion — for more information visit the website of the Growl
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2 Basics

2.1 The Main Window

Active Instruments

Renaming

Instruments

Recent Instruments

Restoring

Instruments

Toolbar

2.1.1 Workspaces

Capture Workspace

In LAMA’s Main Window (Instruments » Main Window
or CMD-M) you can create new instances of instruments
by clicking the corresponding icon in the toolbar, and
you can see an overview of the currently active and the
recently created instruments. The upper table in the
Main Window shows the current instruments — you can
hide an instrument by unchecking the checkbox in the
instrument-list. Hidden instruments are still active and
supplied with audio-signal — so they still use power of
your computer’s CPU. To rename an instrument double-
click the name in the active-instruments table and change
it. The name in the list and the instrument window-title
will change.

The lower table shows the list of Recent Instruments —
when you close an instrument it will be added here. It is
no longer active, has no audio input and won’t consume
any power of your CPU. To restore the instrument, dou-
ble click it in the table — it will reappear on the screen
exactly in the state it was when it has been closed.

You can configure the main window’s toolbar right to
your needs: For every kind of instrument, a toolbar item is
available, additionally there is the Add Instrument item,
which will open a menu where you can select the in-
strument you want to create. Like in other Macintosh
Applications, you can configure the toolbar with View »
Customize Toolbar.

A workspace saves an arrangement of instruments which
can be restored later — the instruments will appear again
with the same window size & position and the same set-
tings.

To save a workspace, click Windows » Workspace » Capture
Workspace. A window named Capture Workspace will
appear.



Update Workspace

Renaming & deleting
Workspaces

Sticky Windows

Capture Workspace

Name Workspace 2
Shortcut [: Type shortcut )
[ Cancel ) \ OK

Enter a name and (optionally) a keyboard-shortcut for
the new workspace.

To update a workspace select Update Current Workspace
in the Windows » Workspace menu. It is possible to up-
date a workspace before recalling an other one. To enable
this, check the appropriate checkbox in the Preferences
Window. (see

To rename or delete a workspace, open the Workspace
Editor with the Edit Workspace item in the Workspace
menu.

Instrument windows have a button with a lock-symbol in
the top-right corner. Use this to make a window sticky.
These instruments (with the lock locked) are not affected
by workspace recalls.

2.2 Creating Instruments

There are three ways to create new instruments:
e the Instruments menu
e the keyboard shortcut of the instrument
e the toolbar icon of the instrument

You can change the appearance of the main window’s tool-
bar by holding c¢MD and clicking the toolbar-icon in the
upper right corner of the window.

It is possible to create various instances of every type of
instrument, e.g. with different settings, window-sizes, etc.
The FFT-Analyzer and the Transfer Analyzer
are able to show the results of several channels in a single
window.

2 Basics
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2.3 Instrument Switching

You can cycle the front instrument window (the one which
will respond to keyboard events) by holding down the
ALT key and pressing the ¢cMD key, or - to cycle into the
other direction - hold cMDand press ALT.

2.4 The Info Panel

2.5 Some Hints
Scroll Wheel

Trackpad

Window Snapping

Parameter Linking

The Info Panel shows information of interest, like fre-
quency & magnitude information of the mouse pointer
in the active window, audio settings and more.

LAMA provides wide support for the scroll-wheel of your
mouse. Move the mouse over a slider or text field and
adjust values by scrolling. This also works on modern
trackpads by performing the ”two-finger scroll”. Speak-
ing of trackpads: LAMA supports the ”Zoom” command
for some instruments. With a ”three finger wipe” (or
cMD-R) you can perform a "Reset” of the current in-
strument.

Instrument windows are designed to snap their borders to
each other. If you want to turn off this behavior temporar-
ily, hold down the ALT key while dragging the window.
When instrument windows of similar type have the same
width or height like an other window it snaps to, they
link their display parameters — e.g. you can snap a Spec-
trum Analyzer to a Spectral History and they display the
same frequency & magnitude range. To prevent parame-
ters from linking, hold down the ALT key while dragging
the windows.

To unlink the parameters, simply move one of the linked
windows to an other position.

2 Basics

11



2.6 Application Preferences

Select LAMA » Preferences (CMD-,) To show a window
with the Application Preferences.

Load last session at startup

Bring all Windows to front...

Update Workspace before recall

Draw standard OS X Windows

Close color panel after...

Show settings view only with double-click

allow drawing of 1/3 oct. details

8,00

General

Preferences

E Load last session at startup
["] Bring all windows to front when becoming active
[} Update Workspace before recall

Appearance
[ Draw standard OS X Windows
Eclose color panel after E] sec.
[ show settings view only with double-click
™ allow drawing of 1/3oct. frequency labels

Transfer Analyzer

[_] Always show Delay Finder Window

Override this setting by helding dawn cmd while
clicking the “Compute Delay” Button.

Recorder
["] Show Recordings Window
Update

EAummaticallv check for updates
Last Check: 16. September 2010 11:33

Check this, to continue exactly how you left it.

When this is checked, all windows will come front
when LAMA was the inactive application and be-
comes active again.

Before recalling an other workspace, the workspace

currently active is updated (it’s current state is stored).

(see Workspaces)

Check this, if you prefer the native OS X windows
style about LAMA’s black windows. Note, that
changes will affect only new created windows.

If this is checked, color panels will be automatically
closed after a specified amount of time.

Per default, LAMA will show the Instrument Set-
tings View (3) when the mouse is moved into the
lower area of the instrument window. You can dis-
able this behaviour by checking this box. The In-
strument Settings View can be shown or hidden by
double clicking into the instrument view.

As default, LAMA will draw a frequency label every
octave (for instruments with a frequency domain.)

2 Basics
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I this is checked, there will be a frquency label ev-
ery third octave, when the window is big enough
(820pixels wide).

Always show Delay Finder Window When this is checked, the Delay Finder will always
open a window showing the impulse response.

Show Recordings Window When checked, the Recordings Window is automat-
ically opened, when the recorder has been stopped.

Check For Updates Check this, and LAMA will check at startup if there
is a newer version available.

2.7 Fullscreen Mode

LAMA provides a Fullscreen Mode, which hides other ap-
plications and displays all windows in front of a black
background instead of your standard desktop wallpaper.

To enter or leave the Fullscreen Mode, use View » Fullscreen
Mode, or keyboard shortcut SHIFT-CMD-F.

2 Basics 13



2.8 Input Patch

The Input Patch Matriz is the connection between the
physical Audio device Inputs and the Inputs seen to In-
struments in LAMA and it is the place where Channel
Name Aliases can be assigned.

Let’s imagine there is a Measurement Mic input on your
system - one day it is connected to input "Analog 1”7 of
your system, the other day to “Analog 8”. Instead of
re-assigning all instrument inputs to ” Analog 8” simply
re-patch destination channel ” Analog 1” to physical input
” Analog 8”. For convenience re-name this input to some-
thing like ”"Measurement Mic” - this is the input name
that instruments will show in audio-input menus.

2.8.1 The Patch Matrix Window

The Input Patch Matrix Window can be opened in the
View » Input Patchmenu, or the Audio Settings Window

— Audio Settings
Window

0.0, Input Patch

(1) Analog 1
(2) Analog 2
(3) Analog 3 x

(4) Analog 4 x

(5) Analog 5 x

(6) AES/EBU 2 x

(7)S/PDIF 1 x

(8)S/PDIF 2 x

(9) Analog 6 x

(10) Analog 7 x

(11) Analog 8 x

(12) AES/EBU 1 x

(13) Mix1 1 x

(14) Mix1 2 x

(15) ADAT Optical 1 x

(16) ADAT Optical 2 x

(17) ADAT Optical 3 x

(18) ADAT Optical 4 x

(19) ADAT Optical 5 b

(20) ADAT Optical 6 x

(21) ADAT Gptical 7 x
(22) ADAT Optical 8 x

3 Analog 1
X Analog 2

Patching The columns of the matrix are the physical device inputs,
the rows are the software inputs seen by instruments. To
patch, simply select a source/destination pair and click
into the field or press the SPACE button on the keyboard.
The destination channel will be renamed, unless an alias
name is set (see below). The destination names are pre-
fixed with the index number of the channel in brackets.

2 Basics 14



Alias Names

Clearing an Alias

Keyboard Operation

By double-clicking the name of a destination channel, an
alias name can be assigned to the channel - this name
will appear in all input menus’s in LAMA. After double-
clicking on the name, a small window will appear on top
which allows to enter the alias. The Next button in this
window can be used to open the alias window for the next
channel - for convenience this can also be done by press-
ing

(1) Analog 1
(2) Analog 2
) Analog 3
() Analog 4
(5) Analog 5§
(6) AES/EBU 2
2)S/PDIF 1
(8)S/PDIF 2
19) Analog 6
{10) Analog 7
11 Analna &

CMD-ALT-CURSOR DOWN on the keyboard.

To clear a channel alias, open the alias window as de-
scribed obove and enter an empty string. There is also the
Clear Alias button in the patch matrix window which
clears all aliases currently set.

It is possible to navigate through the patch window with
the cursor buttons on the keyboard and patch with the
SPACE or ENTER buttons (when using ENTER the next
row & coulumn will be selected after patching). It is pos-
sible to enable or disable mouse patching by switching the
Mouse button on or off.

2 Basics
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3 Instruments

Instrument Settings

1

In LAMA you can create different kinds of instruments:
e Meter - shows audio levels.

e Goniometer - shows a Lissajous of the left and right
channel from a stereo signal.

e Level History - shows the history of peak and RMS
level of a audio signal a the distribution of the val-
ues.

e Spectrum Analyzer - shows the current audio spec-
trum of one or more audio channels.

e Spectral History - shows the audio spectrum of the
recent past of a audio channel.

e Transfer Analyzer - shows frequency and phase re-
sponse of an acoustic system.

e SPL Meter - shows the Sound Pressure Level
e Recorder - records audio to a file

You can create as many instances of an instrument-type
as you like. To create one, use the Instruments menu,
keyboard-shortcut or the main-window toolbar.

All Instruments provide a Settings View — to show it,
make the instrument-window active and move the mouse
into the lower area of the window — the settings view will
now appear in the instrument window.

The Settings View can also be shown or hidden by a
double-click into the instrument view. The automatic ap-
pearance of the Settings View can be disapled in the Ap-
plication Preferences (see Application Preferences).
This view usually shows the most important settings —
like frequency or power range. For more complex set-
tings, some instruments provide a Control Panel .

To show the control panel, click the settings icon in the
instrument Settings View. You can also click the settings



icon at the top-right corner of the instrument window or
hit the keyboard-shortcut ¢cMD-I.
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3.1 Input Meter

The input meter provides a way to monitor the audio-
m levels at the input of your audio-interface. It shows the
peak and RMS Level.

RMS Level The RMS (Root Mean Square) Level is the amount of en-
ergy in the audio signal. The RMS Level is the solid bar
in the meter. The integration time for calculating RMS
is 150 milliseconds.

Peak Level The Peak Level indicates the maximum of the audio sig-
nal and is shown as a line in the meter view. This value
is interesting when setting the input gain of your audio
device to prevent signals from clipping.

Clipping Indicators When input peak levels reach the maximum level of 0dBpg,
the Clipping Indicators turn red. To reset, click into them
or perform a Instrument Reset.

3.1.1 Meter Settings

When you open the meter’s settings window, you’ll see
something like the following:

¥ Soundflower Input Stream #11 10
Soundflower Input Stream #11 11
¥ Soundflower Input Stream #11 12
Soundflower Input Stream #11 13
¥ Soundflower Input Stream #11 14
Soundflower Input Stream #11 15
¥ Soundflower Input Stream #11 16

Signal Generator 1

™ signal Generator 2

| Draw Labels

Hiding Channels In the top you can see a table which displays the names of
all available input channels. On the left of each channel-
name you can see a checkbox — uncheck channels which
should not be displayed in the meter window here.

» Hold down the ALT button, to apply this to all channels.
Furthermore it is possible to navigate through the table
with the cursor keys and toggle the visibility status with
the SPACE button.

Draw Labels The ”Draw Labels” checkbox sets if the name of each
channel should be shown inside the meter. This is proba-
bly a good idea if your meter consists of very much chan-
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3.2 Goniometer

Setting Channels

Correlation

nels. When the labels are not shown although you’ve
checked this setting, there is probably insufficient vertical
space in the meter’s window. Just resize it, and the labels
will be shown.

The Goniometer shows the stereo image of a stereo signal
and helps to avoid cancellations when the stereo signal is
summed mono — by showing possible cancellations. You
can create a new Goniometer with the toolbar icon, the
main menu (Instruments » Goniometer) or the keyboard-
shortcut SHIFT-G.

As there are only two parameters (left & right channel)
for the goniometer-instrument there is no special settings-
window. To set left or right channel, make the Goniome-
ter Window active and move the mouse to the lower part
of the window. The instrument control view with two
pop-up menus for the audio channels will appear.

Goniometer 1

Check Show Correlation to display the correlation of the
input signals. A Value of +1 means that the signals are
identical (mono), -1 indicates a phase reverse.

3 Instruments
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3.3 Level History & Level Distribution

The Level History Instrument shows level history on the
left and level distribution on the right.

3.3.1 Level History

The Level History Instrument shows the Peak- and RMS
Level (see Input Meter) of the recent past. The peak

n level is shown as a solid line, the RMS level is the filled
path.

Settings Use the Integration Time slider to change the time used
for RMS integration & calculation. Input changes the
audio input, Speed changes the display speed of the in-
strument.

3.3.2 Level Distribution

On the right of the Instrument, you can see the Level
Distribution. It shows, how often a certain level existed
in th last time. Main purpose of the Level Distribution is
to:

e See the dynamic range of the programme

e See the perceived programme loudness

Examining the Dynamc Range

Here are two screenshots of the Level Distribution In-
strument, one with very compressed programme ( Red Hot
Chili Peppers — Californication), one with a high dynmic
range (Beethoven — Allegro Con Brio).

Adjusting Time In the Level History view on the right, there is a white
Window marker which allows to set the time window of the distri-
bution. It can be adjusted by dragging and dropping it

in the view.
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Level History 1

Examining the perceived Programme Loudness

For the perceived loudness the 50%-percentile of the distri-
bution is of special interest — it shows a very high relation
to the perceived loudness when measured over a window
of 3 seconds.

In LAMA’s distribution view, the 50%-percentile is shown
with the two little right-facing triangles. Those two facing
left, show the current peak and rms level.

3 Instruments
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3.4 Spectrum Analyzer

With the Spectrum Analyzer you can view the frequency-
spectrum of an audio signal. You can view multiple chan-
nels in a single window.

3.4.1 About FFT Measurements

3.4.2 FFT Basics

FFT-Window-Size

FFT-Window-
Function

FFT (Fast Fourier Transformation) is used for all spectral
measurements in LAMA. FFT provides a fast way to get
spectral information of an audio-signal. But note, that
the resolution of a FFT measurement is linear - the na-
ture of sound would prefer a logarithmic resolution. This
means that the resolution for lower frequencies is always
much poorer than for high frequencies (where resolution
is much to high). So, can you trust the information that
LAMA provides? When you work with a FFT-Window-
Size of 16384 points and a Sample-Rate of 44100Hz you
get an absolute resolution of about 2.7 Hz, which will be
sufficient as long as you are not dealing with super-low
end.

Each FFT Analyzer instrument can display the audio-
spectrum of multiple input-channels. For each channel
you can view the instantaneous, the average and the peak
spectrum. Resolution can be shown in continuous mode
or in ISO-octaves. Other important settings are the FFT-
Window-Size and the FFT-Window-Function

LAMA’s FFT-Window-Size can be adjusted between 8192
and 65536 points. As more points you use, as higher the
spectral resolution will be. Of course, longer FFT-Sizes
will be slower - you can choose between resolution in the
time or in the frequency domain.

A FFT would require that the number of samples of one or
more periods of the test signal are exactly the number of
FFT Points. Of course, this is never the case with music
or speech signals. The resulting effect is called ”Spectral
Leaking”. To minimize this effect, a Window Function is
applied before every FFT process. You can select between
various Window Functions.

For normal music material, a Hanning Window is recom-
mended.

3 Instruments
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3.4.3 Settings

FFT Settings View

Adding & Removing
Channels

Traces

Display Options

To show the settings of the FF'T Analyzer, make the an-
alyzer window active and move the mouse into the lower
part of the window. The FFT Settings View will appear:

Reset

Mode

FoaverRomge - Pink Moise is flat ;

Ly —
Frequency Range  Octave Resolution
e d

“ 1/12 Octave

Here you can change the frequency & magnitude range
plus the octave-resolution for traces which are displayed
in octave mode. For settings like the input-channel or
display-mode you need to open the settings panel: click
the settings icon in the lower right corner of the FFT Set-
tings View or the in the top-right corner of the instrument-
window. The Settings-Window will appear.

Built-in Microphone 1

| Inst. Ort.
| Peak
/| Average
+ o
FFT Size
Peak Fall Rate 16384

Average Rate
—_ . (_Reset Pk

On the left you can see a table which shows all channels in
the analyzer-window. To add or remove a channel, use the
+ or - button below the table. To change the audio-input
of a channel, use the input popup-menu in the upper area
of the settings window. For each analyzer-channel you
can display three different curves: The instantaneous, the
average and the peak curve. Use the Average Rate slider
to make averaging faster or slower and use the Pk Reset
button to reset the peak trace. The fall time of the Peak
Trace can be adjusted with the Peak Fall Rate slider.

For each trace you will find a checkbox which allows to

3 Instruments
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Changing the
Amplitude Range

Showing Frequency

Mode

Details

set if the trace should be drawn or not and a color-well
to set the color of the trace. Furthermore you can set the
display-mode of the trace: Cont. for continuous stroke
(single line), Fill for a filled, continuous curve, or Oct to
display the values in ISO-Octaves. Use Pk Bar to draw a
octave-weighted line.

You can change the amplitude range of FFT & Transfer
windows with the mouse scroll-wheel or by dragging the
background of the analyzer-window up or down — when
you do so in the lower or the upper area of the window,
only the lower or upper bound of the magnitude range is
affected. With multitouch trackpads you can also perform
a "zoom” with two fingers.

Use the Format » Frequency Details menu to show de-
tails about the current cursor position in the window.

As a FFT measurement has a linear distribution over fre-
quency and we as humans are interested in a logarithmic
display there are way too much -or more as displayable-
FFT-points in the upper part of the audio spectrum —
so there has to be a way to reduce the points and to
make the result visible. The Mode Setting changes the
way LAMA performs this reduction. This sets the Accu-
mulation Mode of the display:

White Noise is flat : Shows the mean average of the magnitudes in the

corresponding band.

Pink Noise is flat : Shows the mean average of the energy in the corre-

sponding band. This relates to the way the human
ear perceives a sound.

Peak :  Show the maximum average in the corresponding

band.

3 Instruments
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3.5 Spectral History

The Spectral History Instrument shows the spectrum of
a audio channel during the recent past. The intensity of
= the level is shown by different colors.

To change settings, make the Spectral History window
active, and move the mouse into the lower part of the
window — The settings view will appear. Here you can
adjust frequency and power range & the channel to an-
alyze. The Spectral History Instrument can only show
a single channel per instrument, but of course you can
create multiple instances of them.
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3.6 Transfer Analyzer

b 8 |

Source Independent

Coherence

Time alignment

The Transfer Analyzer allows you to determine frequency
& phase response of acoustical or electrical systems, like
preamps, equalizers or a venue with speakers.

Transfer measurements in LAMA work independent from
your source signal (unlike other applications which require
a special test-tone). To be able to do the measurement,
LAMA needs two sources for each measurement: The
Source Signal, which is the signal at the input of your
system (when the system is a room, this would be the
mixing desk output) and the Response Signal which is
signal at the output of the system (in the same example
this would be the output of a measurement microphone).
When setup, you get three different results: the Magni-
tude, Phase and the Coherence Trace.

The Coherence is of particular interest: It shows how the
response signal relates to the source signal — you can in-
terpret it as the ”quality” of the measurement. Reasons
for low coherence (or bad quality) can be noise or other
unrelated signals in the response signal - like a loud au-
dience or the reverb of the room. An other reason might
be cancellation of particular frequencies at your measure-
ment microphone (comb filtering) - as these frequencies
are not available in the response signal, the response of
these frequencies can’t be determined. To improve read-
ability of the magnitude trace, it’s opacity depends on
the coherence. This means that it will be faded out in
areas with low coherence. To improve coherence of your
measurement, it is important to have source & response
signal time aligned. Usually the response signal will be
late (time delay between speakers & measurement micro-

3 Instruments
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— B64

phone), so LAMA provides a delay for the source signal
to have it aligned to the response signal. See the Section
Delay Finder to learn how LAMA can achieve automatic
time-alignment for you.

3.6.1 About Transfer Measurements

— 22

— B63l

Magnitude Options

Offset
Invert
Smoothing

»

A Transfer Analyzer is created with the toolbar of LAMA’s
Main Window , the Main Menu (Instruments » Transfer)
or with the keyboard shortcut SHIFT-T.

Every Transfer Analyzer Window can hold various Real-
time Analyzers, Snapshots, Averages and a special kind
of average-snapshot, the Accumulator. Some settings are
common for all types:

/| Magnitude
Details

Offset === |00 dB
Inwert 1/3 Octave

Fhase

Coherence

For each trace (Magnitude, Phase & Coherence) you can
find a checkbox which sets if this trace should be drawn
or not and a color-well to select an other color for the
trace. For the magnitude trace you have some more op-
tions: You can select if you want the result being shown
as a single, continuous path (Cont.), as a filled continu-
ous path (Fill) or if you prefer the result in ISO-Octaves
(Oct.). The 0ffset parameter adds an offset on the re-
sult, Invert inverts the result. The magnitude curve is
always smoothed in fractions of octaves, use the pop-up
menu or keyboard shortcut to set the smoothing amount.
You can use M, P or C key to show/hide magnitude,
phase or coherence curve.

3 Instruments
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3.6.2 Realtime Transfer Measurements

Realtime measurements are performed with signals cur-
rently fed into LAMA, and are represented with the icon
shown on the left. Besides the parameters introduced

— B6d at the beginning of this chapter you can see some more
options:

Source | Analog 7

Response | Analog 4

Averaging fast e=——=l=—— inf

Input Channels There are two pop-up menus named Source Channel &
Response Channel, which are used to set Source & Re-
— 3.0 sponse channel of the measurement.
Averaging The Averaging slider sets, how fast a realtime-measurement
is averaged, the maximum value at the right is infinite.
When infinite averaging is selected, you have to reset the
analyzer manually by clicking the Reset button.

Reset Additionally you can find a parameter named When fun-
damental parameters of your acoustic environment have
changed, it may be necessary to reset the transfer ana-
lyzer by clicking the Reset button. When the delay time
is changed, a reset is automatically invoked.

Pause The "Power Switch” gives the opportunity to stop a re-
altime measurement — it will remain with it’s current data.

» CMD- Click the power switch to toggle the signal-generator’s
Mute switch. Use keyboard shortcut O to toggle the mea-
surement’s pause status.

Delay Time  The reference and measurement signal must be time-
aligned in order to get good measurement results. The
delay time is set in the delay time settings view.

» Usually, there is no need to enter delay times manually,
you should alway use the Delay Finder to calculate delay
times. When the delay finder fails, this is usually an in-
dication that something is wrong with your measurement
setup.

For more details, have a look into the Delay Finder sec-
tion in this manual.
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Delay Time Reference

3.6.3 Snapshots

Averages

The Accumulator

Delay Finder... |f§;| 3.94m

Ref.: 3.45m

A delaytime reference point can be entered into the Ref.
text-field. The displayed delay time is relative to this
reference point.

You can create a snapshot of a realtime measurement by
clicking the snapshot icon in the toolbar of the transfer
settings view.

Snapshots save the current state of the measurement and
can be used to create averages of two or more snapshots.

If you do room correction you will get (more or less) dif-
ferent results on every different position in the room. If
you have created various snapshots on different positions,
you can use the average item in the toolbar to build the
average of the selected snapshots.

An easier way to achieve this can be to make use of the
Accumulator, as described below.

As mentioned above, it is recommended and required to
do measurements on more then one point in the room
and to average them, when you are trying to do room-
correction. The Accumulator makes this very easy for
you — it is a kind of growing average-memory. When the
measurement on a specific point is set up and ready, sim-
ply click the push to accumulator icon in the toolbar.
The selected measurement will be added to the accu and
averaged with all other measurements there.

Click Reset to reset the Accu. (On some trackpads you
can use the three-finger-wipe to reset.)
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Snapshot Differences

A

3.6.4 Delay Finder

Viewing Results

Snapshot Differences display the difference of two snap-
shots. To create one, select two snapshots in the source
list, and click the delta icon in the toolbar.

As mentioned above, it is important that source and re-
sponse signal are time aligned. LAMA has the Delay
Finder, to compute the delay between source & response
channel. You can start the process by clicking the Compute
button. As the delay finder needs signal to work, the delay
computation is triggered when both source- and the re-
sponse signal exceed a level of —26dBpg.

Delay computation works best with static broadband noise.

When the delay-computation is finished the text-field in
the lower right corner of the transfer-settings window will
show the calculated delay-time.

If you want to change the delay time manually, just enter
an other value into the text-field. You can change the
distance-unit in the Format » Distances menu.

You can enter a value in an other unit by adding the suffix
"m”, ”ft”, "msec” or "smp” (for meter, feet, millseconds,
or samples) to the number you enter.

If you are not sure if the result of the delay finder is
correct you can view its results in a separate window.
Click the settings button next to the Compute Delay to
open the delay-finder window. (Note: you can set in
LAMA’s Preferences to always open a delay-finder win-
dow, or you can hold down the cMD key when clicking the
Compute Delay button.)

In the delay finder window you can see the impulse re-
sponse of the tested system.

By default, LAMA sets the delay-time to the highest peak
in the impulse response. Now, you can change the delay-
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time,

by simply clicking to an other position in the delay-

finder window. To set the delay time to the peak in a
Select range of particular range, select thearea that is interesting for you.
interest Now the delay time will be at the maximum-value in this

area.

» Hold down the cMD key while selecting to zoom into the
selected area.

Keyboard Shortcuts The following keyboard shortcuts are available in the de-
lay finder window:

CURSOR LEFT
CURSOR RIGHT
Cursor Up
CURSOR DOWN
CcMD-CURSOR Up
CMD-CURSOR DOWN
CMD-CURSOR LEFT
CcMD-CURSOR RIGHT
ALT-CURSOR LEFT
ALT-CURSOR RIGHT

SHIFT-CMD-0

Scroll left

Scroll right

Increase Delay Time

Decrease Delay Time

Increase Reference Point time
Decrease Reference Point time
Zoom Out

Zoom In

Jump to Reference Point
Jump to Delay Time Point

Reset View — Zoom to a level where reference point
and delay time are on screen.

» Holding down the SHIFT key increases the amount ap-
plied, when scrolling or moving delay or reference points.
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3.7 Recorder

Non-Linear PCM
Formats

Multichannel Files

Input Patch

Recording
o

With the Recorder you can save audio signals to an audio-
file. The audio-file-recorder that comes with LAMA sup-
ports a wide range of file & format types.  Open the
recorder to see a list of available file-formats.

800 Recorder 1 (]

(o)
e
Record

File Format Audio Format:

[ Apple CAF File (caf) %] [LinearpcM %) | (npur Patch =)

Stream Format: Bit Rate:

(_Linear PCM, 24 bit linle... (4]

™ Support Non Linear PCM Formats

2 Channel Apple CAF File, Linear PCM, 24 bit it endian signed integer.

The recorder is able to record compressed formats like
AAC. Please not that recording of such Non-Linear PCM
Formats requires much more CPU-Power than recording
Linear PCM. Use the Support Non-Linear PCM formats
checkbox to enable the recorder to record such types (and
show them in the list of available formats.)

With LAMA’s recorder, you can record multichannel-files.
The number of available channels is dependent on file &
audio format.

Please note, that not every other audio-program is com-
patible with every type of audio-file. You might want to
check before making an important recording.

With the Input Patch menu you can select the number
of channels for you audio file, and which input-channel
should be routed into which destination channel in the
file. You can navigate thru the path menu with the cursor-
keys, and patch with the SPACE or ENTER key. To achieve
a 1:1 routing, double-click at the start-patch point.

To start recording, click the Record button in the tool-
bar. The recorder view will change, and show a waveform
overview of the channels currently recorded.

Recorder 1 =]

. ARC, Sample Rate: 44 126000 bps i
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3.7.1 Recordings Window

The Recordings Window shows recently recorded files.
—E1T It is possible to add a recording to the File Player by sim-
ply dragging the recording from the Recordings Window
& and dropping it on the File Player’s file list.
A recording’s file can be revealed in the Finder by double-
clicking on the file. Recordings can be removed from the
list by selecting an item hitting backspace on the key-
board or choosing Edit » Delete.
Open Recordings  As described in Section[2.6] you can check Show Recordings
Window Window in LAMA Preferences to open the Recordings
automatically Window automatically when a recording is stopped.
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3.8 Sound Pressure Level (SPL) Meter
3.8.1 Introduction

! =& The Sound Pressure Level Meter may not meet
the legal requirements of your local authorities!
The SPL-Meter shows the current, averaged and peak

&dﬂ-’t Sound Pressure Level, computed with a user-settable weight-

SPL ing curve. Besides the current SPL, it shows the following:

AVG The arithmetic average, averaging time is settable
in a range from 10 seconds to 30 minutes.

PK Peak SPL - use Instrument Reset to reset peak.

LEQ FEquivalent Continuous Sound Pressure Level or Sound
Ezposure Level. 1t is reset after a certain period
which can be adjusted by the user. The SPL Meter
displays the time since it has been reset and when
the next reset will occur - the remaining time until
reset is shown in brackets.

SPL Meter 1 - )

- 86.7 dB

90 A-Weighted, Slow

AVG: 73.9dB
PK: 95.1 dB

LEQ: 80.0 dB (75)

1r

The following parameters are adjustable:
e Weighting Curve:
— dB(A)
— db(B)
— db(C)
e Speed:
FAST Measurement Time 125 ms
SLOW Measurement Time 1.2 sec
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e Average Rate, in a range of 10sec to 30min

SPL Meter 1

— — |
Big Window o B

Show Log

90 AVG Time LEQ Time W

10min § 30min  §
0 Speed Weight
Slow 3 A-Weighted
Input

50 Built-in Microphone 1

Reset Peak To reset the Peak Value, simply perform Reset Instrument,
either in the Edit menu, the keyboard shortcut cMD-R
or a ”three-finger-wipe” gesture on your trackpad.

LEQ Prediction  Based on the linear average of the last minute, a pre-
dicted LEQ value is calculated and displayed. This is the
value shown in brackets in the LEQ line.

3.8.2 Calibration

The SPL-Meter needs to be calibrated before it can be
used, as the level depends on the measurement micro-
phone and audio interface being used. To start the cali-
bration process, open the settings view of the SPL Meter:

“Calibration | _Cal. Dictionary | Alert

Manual Calibration Current SPL:

—_— e 45.7dB
Calibration to specific Value:

94 dB

Notes for Calibration:

Enter some notes for calibration, like

the gain value of the audio device and | |
type of measurement microphone) |

A

Cancel
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Manual Calibration

On top of the calibration view, you can see a slider named
Manual Calibration and a text field named Current
SPL. Use these for "quick & dirty” calibration:

e Bring your measurement mic as close as possible to
the mic of an other, calibrated SPL Meter

e Adjust the slider until the Current SPL textfield
shows the same value as the calibrated SPL Meter.
(Make sure that weighting-curve and measurement
speed match)

e Click OK

Calibration with a known SPL

When you want to calibrate to a known Sound Pressure
Level - like with a SPL-Calibrator, use the Calibration
to a specific Value area of the Calibration Window.

e Choose the appropriate SPL in the menu (select
Custom to enter a custom value)

e Expose your microphone to the sound-field (plug it
into the calibrator)

e Click GO!

Notes for Calibration

Once calibrated, you might want to use the same setup
again. The Notes for Calibration text-area allows to
enter some notes (like the type of the measurement mic
used and the gain-settings of your audio-interface). that
will help to reproduce the setup you have calibrated.

Reusing Calibration

To apply settings from a setup that once has been cal-
ibrated, click Cal. Dictionary in the calibration win-
dow.

You can see a menu, showing calibrations done with the
current audio interface. To reuse this value, select one
and click OK.
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3.8.3 SPL Alert

Calibration | Cal. Dictionary

MOTU Traveler - 12dB

Calibrated 94 dB @ Gain 12dB, no g
PAD

Microphone: Audix TR40

More...

Cancel

If you want to, you can be alerted when the sound pressure
level exceeds a certain limit. You will be alerted with a
GROWL notification.

! | SPL exceeded B80dB

0 Sound Pressure Level above Limit

SPL

Growl is an external system extension, which needs to be
installed to make this feature work. For more information,
visit the |Growl website. The advantage of Growl is that
notifications can be forwarded to an other computer by
network, SMS, etc.

To enable SPL Alert and set the alert level, open the
SPL Meter Settings Window, and select the Alert Tab:

There is a checkbox Post SPL Alerts which allows to
enable or disable alerts. The desired alert level must be
entered in the Level text-field.

Only one SPL alert will be posted each time. The Growl
Notification window must be dismissed to receive a new
alert.
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http://growl.info

Calibration | Cal. Dictionary | Alert_

| Post SPL Alerts

Level:

80 dB

You need to have the Growl Extension
installed to make this work.

Cancel

3.8.4 Big SPL Window

Every instance of a SPL Meter instrument allows to open
one or more Big SPL Windows. It is created with the Big
Window button in the control view of the SPL instrument.
A big SPL window displays the current SPL, AVG, LEQ
or Peak value. Contrary to the SPL Main Window, these
are resizable — this way a bigger readout for the numbers
can be achieved.

SPL "Traffic Light” The big SPL Windows allow to set a threshold for a warn-
ing and a alert level. The number readout will change
color if the current level is above this threshold.
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3.8.5 SPL Logging

Starting Log

This logs the instantaneous, average and LEQ Level. Data
is stored on disk and can be exported later as .csv file.
Use the Show Log button in the SPL Instrument settings
view to show the SPL Logging View.

Start Logging

Export Data...

The SPL Logging View has it’s own settings view, where
you can set colors for traces and show or hide them.

To start SPL Logging, simply click the Start Logging
Button in the SPL Logging View. You can hide the log-
ging view if you want while it is logging.

3.8.6 SPL Log Window

Naming Logs
Delete Logs

Export Log Data

When a SPL Log is stopped it will be saved automatically.
SPL Log Window will show all logs that have been saved.

This window can be opened with Windows - SPL Log or
keyboard shortcut ALT-SHIFT-L

Every Log item can be named individually e.g. ”Re-
hearsal”, ”Show”,... by double-click on the name in the
log-table. Log items can alos be deleted, by selecting Edit
- Delete or the Delete button.

In the SPL Log Window, SPL data can also be exported
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as .csv file — these can be easily imported into a spread-
sheet application like Open Office.

Select a log item and click Export... — a save sheet will
appear in the window. The following export options are
available:

Range

Separator

Date Style
Time Style

Decimal Sep

SPL, AVG & LEQ

Preview

Range: ((1mn ) Datestyie: [ 291109 1) Decimalsep:
Separator: [ 7) Time styie: [ 14:18:28 B =

Preview: [TIME SPLAAVG LEQ CEE
201108 14:01'12:58 4:56.6:54,0
29.11.09 14:02:12:60.0,56,2,54.2 “ave
2011001403121 1557.754.

The export range. LAMA logs SPL level’s every
second. If you want to export with a resolution of
one minute for example, set this value to 1 min..

You can use ”;” 7.7 or a tab-character as column-
separator.
The Date style for the export data.

Time style for the export data.

” N

” N
* )

Set if you want a poin or colon as decimal

separator in the export data.
Check which data to export.

This shows how the exported data will look like.
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3.9 Netsend Instrument

— ETT

B, -y
i

The Netsend Instrument uses the system supplied A UNet-
Send Audio Unit to stream audio signals over network.
The audio stream sent can be received with the AUNe-
tReceive Audio Unit, like with the Net Receive instance
in LAMA.

ovo LAMA Net Send 1

Ch 1: Format:

Built-in Microphone 1 7 | | PCM, Float 32 bit

Ch 2: Port: Password:
Built-in Microphone 2 7 | | 52800

® Connected Disconnect

You can set two input channels for the Audio Stream
(Ch 1 & Ch 2), a network Port, the Stream Format and
a password.

Currently (Mac OS X 10.6.2) there are some issues with
certain kinds of stream formats when LAMA is in 64 bit
mode. You can launch LAMA in 32 bit mode if this is a
problem. However, Linear PCM formats work fine in 64
bit mode.
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3.10 Oscilloscope
= The oscilloscope shows the audio signal of two different

channels.

Input In the top area of the control view you can find two popup-
menus to select the audio-input of oscilloscope channel 1 & 2.
Use the checkbox left to the labels to set if the channel
should be shown or not.

Trigger Use the Trigger Source menu to set to trigger on chan-
nel one or two. The oscilloscope’s view will be redrawn
when the level on the trigger channel exceeds the level set
with the Trigger Level slider.

Time Resolution On the bottom of the oscilloscope control view, there are
two popup-menus to set the time-resolution of the oscil-
loscope. The one on the right sets the unit (either sam-
ples per division — smp/div or microseconds per division
— usec/div)
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4 Aux Inputs & Additional Channels

4.1 Awudio Settings

Audio Settings The Audio Settings Window is the place where you can
Window select the audio device which will be used for input and
where you can create Summing channels or an instance of

File Player, Net Receive or the Signal Generator.

800

MOTU Traveler

4.1.1 Auxiliary Inputs

If you need to do measurements with audio signals from an
other source then your audio-interface, - e.g. the content
of an audio file on your hard disk - LAMA has three dif-
ferent kinds of ”auxiliary” inputs: file-player, net-receive
unit and the signal generator. The audio signal of these
aux-inputs (which is always a stereo signal) is routed
into LAMA and can be treated in the same way as a



Default Stereo
Output

Creating Aux Inputs

File Player

"normal” input-channel of your audio-device. Addition-
ally, their signal is fed to the default stereo-output of
your Macintosh. The stereo-output can be set with the
Audio MIDI Setup application which can be found in the
Utilities folder inside the Applications folder on your Mac-
intosh hard disk.

Please make sure that this output-device is working with
the same Sample Rate as the input-device currently used
by LAMA.

Auxiliary Inputs are created in the Audio Settings Win-
dow. Just check the box of the appropriate type you want
to create and it will be active. To show the window of the
aux input, click its Settings Button. Note that only one
instance of each type can be created.

Note, that Aux-Inputs use CPU-Power — you should deac-
tivate them if they are not needed in the Audio Settings
Window.

As creating or removing Aux-Inputs changes the audio-
configuration in LAMA (which requires stopping & restart-
ing the audio-engine) it is not possible to create or remove
them while a recorder is recording.

With the File Player you can play back audio files:

8,00 File Player
Audio Files +...
no file selected
Sample Rate: nfa Length: n/z
pe—————
@™ 00:00 ™ autoplay

LA gl L
L |

.REQIUI'I + Start Duration Loop

Output Volume; = 00 dg
' i

Drag audio-files from the finder and drop them on the
Audio Files table, use the transport buttons to start or
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Volume pause playback. Use the Output Volume slider to adjust
the volume that is fed to the stereo-output — Note that
the level to the output is independent to the level fed to
LAMA internally (which is always the maximum level).

Net Receive

The Net Receive Unit works in conjunction with the AUNetSend

— B3 Audio Unit or the Netsend Instrument in LAMA . It
makes it possible to stream audio-data over a TCP/IP
network. Setup an other computer with AUNetSend and
LAMA will be able to receive the sent audio-stream.

Net Receive

Password:

® Connecred

10.37.129.2:52800

Disconnect

Signal Generator

LAMA'’s integrated Signal Generator can generate test-
signals of the following types:

e Sine Wave

e Sine Sweeps

e Pink Noise

e White Noise
Select the tab with the kind of signal you like and adjust
its settings.

Levels The Amplitude slider sets the level with which the signal

is being generated and fed into LAMA’s Instruments, the

! —  Out slider sets the level which is fed to your output. To

prevent your ears and nerves from damage, the Out slider

is always in -Infinite position when you create the signal
generator.
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4.1.2 Summing Channels

When you need to do measurements that depend on the
sum or the difference of two other channels, you can create
a ”"Summing Channel”. A Summing Channel is an addi-
tional input to LAMA with Sum & difference of two other
audio-channels. They are created in the Audio Settings
Window (by clicking the + button at the bottom of the
window) and select two channels for it. The sum and the
difference of these channels will be fed into LAMA’s in-
struments as two additional audio channels. If you want
to remove them, select the channel and click the - button.

! — Note, that Summing Channels use CPU-Power — you should

deactivate them if they are not needed in the Audio Settings
Window.
As creating or removing Summing Channels changes the
audio-configuration in LAMA (which requires stopping &
restarting the audio-engine) it is not possible to create or
remove them while a recorder is recording.
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Appendix A Appendix

A.1 Troubleshooting

If you do experience ongoing troubles with LAMA| please
contact us: contact@lama-audio.net.

Delete Preferences You might want to try trashing LAMA’s preferences file,
which can be found in Home/Library/Preferences/com.nobusiness-
soft. LAMA.

Last Session The settings of your last session are stored in a file name
lastsession.lama which can be found at Home/Libraray/Application
Support/LAMA. It might cause problems at startup, when
this file is corrupted.

Starting in 32bit Some problems might be specific to 64bit operation —
mode there is a known issue that certain stream formats in
AUNetSend a AUNetReceive do not work correctly when
LAMA is in 64bit mode.
To start LAMA in 32bit mode, select the application icon
in the Finder and show the Info Panel (cMD-I) You can
find a chackbox reagrding 32 bit operation there — check
it and relaunch LAMA.
License When starting LAMA for the first time, you will be able
to try it for 30 days without any restrictions. Note that
LAMA has to communicate with our server on the inter-
net to do so. Of course your privacy is fully respected.



A.2 License

A.2.1 End User License Agreement

License Grant

Title

Limited Warranty

Limited Remedy

”You” means the person or company who is being licensed
to use the Software or Documentation. ”We,” "us” and
7our” means Ulrich Zurucker.

We hereby grant you a nonexclusive license to use the
Software by one person. The software may be installed
on as many computers as necessary, provided that you
have a license for each person using the software.

We remain the owner of all right, title and interest in
the Software and related explanatory written materials
(?”Documentation”). To the extent permitted by applica-
ble law,

THE FOREGOING LIMITED WARRANTY IS IN LIEU
OF ALL OTHER WARRANTIES OR CONDITIONS,
EXPRESS OR IMPLIED, AND WE DISCLAIM ANY
AND ALL IMPLIED WARRANTIES OR CONDITIONS,
INCLUDING ANY IMPLIED WARRANTY OF TITLE,
NONINFRINGEMENT, MERCHANTABILITY OR FIT-
NESS FOR A PARTICULAR PURPOSE, regardless of
whether we know or had reason to know of your partic-
ular needs. No employee, agent, dealer or distributor of
ours is authorized to modify this limited warranty, nor to
make any additional warranties.

SOME STATES DO NOT ALLOW THE LIMITATION
OR EXCLUSION OF LIABILITY FOR INCIDENTAL
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

Our entire liability and your exclusive remedy for breach
of the foregoing warranty shall be, at our option, to either:

e return the price you paid, or

e repair or replace the Software or media that does
not meet the foregoing warranty.

IN NO EVENT WILL WE BE LIABLE TO YOU FOR

ANY DAMAGES, INCLUDING ANY LOST PROFITS,

LOST SAVINGS, OR OTHER INCIDENTAL OR CON-

SEQUENTIAL DAMAGES ARISING FROM THE USE

OR THE INABILITY TO USE THE SOFTWARE (EVEN
IF WE OR AN AUTHORIZED DEALER OR DISTRIB-

UTOR HAS BEEN ADVISED OF THE POSSIBILITY

OF THESE DAMAGES), OR FOR ANY CLAIM BY

ANY OTHER PARTY.
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Term and
Termination

A.2.2 Privacy

SOME STATES DO NOT ALLOW THE LIMITATION
OR EXCLUSION OF LIABILITY FOR INCIDENTAL
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU. This license
agreement takes effect upon your use of the software and
remains effective until terminated. You may terminate it
at any time by destroying all copies of the Software and
Documentation in your possession. It will also automat-
ically terminate if you fail to comply with any term or
condition of this license agreement. You agree on termi-
nation of this license to destroy all copies of the Software
and Documentation in your possession.

The makers of LAMA fully respect your privacy. LAMA
will send data over the internet in some cases:

e When starting without a valid license, the serial
number of your computer will be sent.

e When checking for updates, LAMA sends some tech-
nical information about your computer hardware —
we use this for statistical purposes.

e When sending crash reports some technical infor-
mation is sent too.

LAMA will never send data in other cases then those de-
scribed above and will never use any private information
saved on your computer. Please contact us, if there are
any questions left on privacy.

A.2.3 Contact Information

For legal questions, please contact us:
Ulrich Zurucker

Tengstr. 8

80798 Munich - Germany
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Link
Instrument Parameters,
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loudness,

Net Receive,

Netsend, [41] [47]
Oscilloscope,

pink noise is flat, [24]
Preferences,

Recorder, [32] [44]
Reset,
RMS Level, 18] [20]

Sample Rate,
Scroll-wheel,
Signal Generator, 5]
Smoothing,
Sound Exposure Level,
Sound Pressure Level,
Spectral History,
Spectrum Analyzer, [22]
SPL, B4

Alert,

Logging, [39]
Stereo Image,
Sticky Windows, [10]
Summing Channels, [40]
System Requirements, ]

toolbar, [9]
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Trackpad,

Transfer Analyzer,
Accumulator, [29]
Averages, 29
Delay Finder,
Realtime,
Snapshots,

white noise is flat,
window snapping,
Windows,
Workspace, [9]
update, [I0} [[2]
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